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1 - LabSpecS general overview

LabSpec 5 is a general data acquisition and data analysis software, based on open
NexGen module architecture. LabSpec 5 controls all the HORIBA Jobin-Yvon Raman
instruments, enables different data acquisition modes(eg. single spectrum, multidimensional data
set, video image etc.)
The data analysis routines include many commonly used Raman and FTIR tools, such as baseline
correction, linear and non-linear filters, peaks fitting Kramers-Kronig transform etc. The mapping
technique enables to generate and visualize map by using different spectral features : band
intensity, peak position and so on.
The module architecture allows to customize software to support specific operation, for example
read foreign data file format, implement data acquisition trigger etc.
The Visual Basic script language of Microsoft is supported, that yield possibility to create macro
commands or include specific data analysis function. The LabSpec 5 can be used also as Active X
control in third part application.
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2 - LabSpecS5 installation
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3 - LabSpecS main window

The main menu bar

The main icons bar

Graphics tools associated
to the active object.

£ LabSpec - Spectrum : d03

File Edit Options Maintenance  Acquisition  Data  wWindow Help

2 wd & K

&7

# Spectrum : d03

fWindow of the
~active objects

0B B I D e WS | Al [ A

Intensity (end)

TPyt 09 ETE

— Lazer Filter ~ Hole Sl - Spectro
The COIltrOl panel ‘ i IE B E h 12400 L! -@- |‘| ﬁ
- ’ @H[ﬂ@“@[ﬂ%ﬁg?lmuzj Ol
| =T I Nl BB || BB | (P72 1em | [Test O |1
The status bar #
For Help, press FL [ 300,505 862 o
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4 - The main menu bar

The main menu bar is located on top of the LabSpec5 main window.

¢ LabSpec - Spectrum : Chalcopyritel

File Edit Daka Acquisition  Options  Setup Window  Help

4.1 - File menu
The File commands menu permits to manage the data files and the data printout.

To access the File menu click on the File button of the main menu bar or type Alt+f or Alt+F keys.

Cpen. .. Chrl+0
Data file management functions Close

4’ Save CErl+5

Save Al

Pririk. .. Chrl4-P
Data printout management functions Prink Preview

TP Frint Setup...

Page...

1 ¥¥Image_benzen_ 1103 30_10.kvf
Last loaded files > 2 Viden_porkl. TvF

5 ¥¥Image porkl 1151 126 140.TYF
4 CASaV res-rad-x40-325.ksF

Exit
» Data file management functions
Open........ccccovevveveereenennn. To open a previously saved object for display.
Close To close and to remove the current object
Save To save the current object in a file for later retrieval
Save All To save all the objects of the current window.
» Data printout management functions
Print... Output to the default printer.
Print Preview......ccoccevueenncee To preview the page before printing.
Print Setup.....cccceeervcersacens To setup the printer parameters
Page... To define the layout of the page.
Exit To close and quit the LabSpec$ application.
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4.1.1 - Open... function

The Open... command permits to select a previously saved file to load it.
To access this command select Open... from the File commands menu in the Main menu bar or use the

keyboard shortcut Ctrl + O or click directly on the following open icon

Select here the folder in which
the file has been saved.

b

in the main icons bar.

Laok in: | (27 single window

| & & o E-

Select in the list of files the ylLLispectrum Siicon 1015, bsFi

one you wish to load.

Click on the Open button
to open the selected file.

Click on the Cancel

File name: |

Select here the type of

button to abort the
|| operation and to close the

the researched file.

-—?Files of tupe; ] LabSpec [* b bvi]

window.
LJ Cancel

4.1.2 - Close function

The Close command removes the current object of the active window without saving the changes.

To access this command select Close from the File commands menu in the Main menu bar.

4.1.3 - Save function

The Save command permits to record the active object in a file for future retrieving.

To access this command select Save from the File commands menu in the Main menu bar or use the

keyboard shortcut Ctrl + S or click directly on the following save icon & in the main icons bar.

Select here the folder in which

avein; |\_? single windaw

you want the file to be recorded.

|iI L spectrum_Silicon_1015.ksf

List of the files already
existing in the chosen folder.

Click on the Save
button to save the
selected object.file.

Enter here the name you .
wish to assign to the file. __-WPFie name:

Click on the Cancel

S}as type: ] LabSpec [*.tzf]

/
Select here the file format.

= Came* button to abort the
\

operation and to close
the window.
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4.1.4 - Save All function

The Save All command permits to record all the objects of the active window in a file for future

retrieving.

To access this command select Save All from the File commands menu in the Main menu bar.

you want the
recorded.

Select here the folder in which
file to be

Save in: ID zingle windam

List of the files already
existing in the chosen
folder.

= = & cF B

spectrum_Silicon_1015 ksf

Enter here the name you

wish to assign to the file. A

_’File name:

Select here the file format.

4.1.5 - Print function

/

Sawve

*ve az bype; iLabSpec [".k=f]

_:l Cancel ﬂ’

Click on the Save
button to save the
selected object.file.

Click on the Cancel
button to abort the
operation and to
close the window.

The Print... command prints out to the default printer the objects of the active window. The layout page
is the one defined with the Page... command.
To access this command select Print... from the File commands menu in the Main menu bar or use the

keyboard shortcut Ctrl + P or click directly on the following print icon | S | in the main icons bar.

£ LabSpec - Spectrum : Chalcopyrite1

File Edlt Data  Acquisition Options Setup Window  Help

£y

i

|n.\-;m
|

J

s s

|8 | = Ellik‘?“%vﬁﬁwﬁ L 5 [[Ie B R g M S o || Mt e

File menu

Open,,
Close
Save
Save &l

Print Print. ..
o Prink Prewview

Page...

Print Setup...

CErlP

Exit

1 Caffeine-3green.tsf
2 Diamaond? ksf
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4.1.6 - Print Preview function

The Print Preview command allows to display the to-print page before printing.
To access this command select Print preview from the File commands menu in the Main menu bar.

> The Print Preview window

The to-print page is displayed in the print preview window as it will appeared at print out so you can
check the page layout before starting the printing operation.

To modify the page layout , use the Page... function of the File menu.
On top of the print preview window some specific buttons commands are available.

Print PreVieW £ LabSpec - Spectrum : CYCLOZ
Speclﬁc Commands i MestPage | Frev Page Zoom [ ZoorEut

The to-print page

HORIBAJCBIMN vV

B0 114210

Page 1 | (70649 146 | 4

The Print Preview commands

| Click on this button or press P-key or p-key to start the print out.

ml Click on this button or press N-key or n-key to display the second page in case of a to-print
document on 2 pages. For the moment the layout of a to-print document is only on one page.

u’eﬁ “““ | Not available. (Future expansion)

M-Click on this button or press T-key or t-key to display the 2 pages of the document. Useful
for to-print document on 2 pages (future expansion)

ﬂl Click on this button or press I-key or i-key to zoom the previewed page.
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M Click on this button or press O-key or o-key to zoom-back the previewed page. This button is
available only if the Zoom function has been activated .

ﬂ Click on this button or press C-key or c-key to quit the Print preview function and to return to

the LabSpec5 application.

4.1.7 - Print Setup function

The Print Setup... command permits to select the printer and to define its properties.

To access this command select Print Setup... from the File commands menu in the Main menu bar.

» The Print Setup window

Select here the printer to use.

Select here the format of the
sheet of paper to use and its
location in the printer.

Click on this button to
choose a printer on
your network.

| /'Netﬂork...

Print Setup

Printer

Status: Ready
Type: HF Desklet 330C/932C/935C
“Wwhere:  LPT1:

Comment:

\ Paper

Size: |ad =]

Source: 1Sélection automatique Lj

Orientation

Eancel‘

Froperties...

Click on this button to check
or set the parameters specific
to the model of the printer
used. Report to the manual
of your printer for detailed
information.

{~ F'grtrait<
iCs Lgndsc(

The orientation parameter is
linked to the one set with the
Page... function.

Click on the OK button
to validate the settings
and to close the window.

Click on the Cancel button
to abort the changes and to
close the window.

LabSpec) manual
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4.1.8 - Page function
The Page... command permits to define the layout of the to-print document.

To access this command select Page... from the File commands menu in the Main menu bar.

> The Page window

Page tools bar Components of the to-print page

Header page —
Associated toole:

Each icon allows to
define the size and

Data object
the position of each EJ

_cancel || Associated tool:

different predefined [P
component type of
the to-print page

Text object
AD

R LAVl il - DR

et : : f e / Associated tool:

HORIBA. BN Y g

graphic object
Associated tool: ,BJ

\ —
L — » | Image object i
/ Associated tool: s

Information parameters Bottom of page
—

Associated tool: i= Associated tool:

» The page buttons
Load | To load an already recorded template.

J To save the current template into a file.

Save

To validate the settings and to close the Page window.

e | To close the Page window without validating the current Page settings.
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> Using the Page tools icons

To insert a component in the to-print page click on the corresponding tool. Then move the mouse on the
page so a cross appears. Then move the cross at the wished location, press on the left mouse button and
move the mouse to define the size of the corresponding component.

> How to select a component of the to-print page

Move the mouse on the chosen component and click on the left mouse button. Then a dotted rectangle is
displayed around the selected component.

> Moving a component of the to-print page

Select the component. Then when the following mouse cursor FI_’ appears, click on left mouse button and
drag the mouse.

> Re-sizing a component of the to-print page

First, click on the object to select it. Selection handles appear around the selected object.
lhandle of selection

b i o e P e

1

B el et

e

Move the mouse pointer on one of the selection handles until to have the size pointer:

Ior ' .Keep the mouse button pressed and move the selection handle and modify the size of the object.
> Modifying or creating the contents of a to-print page component

Except the data object, the contents of all the other objects could be modified by double-clicking on the
wished component.

Then a dedicated window appears with the tools to modify the corresponding component:

- The options window for the header page, the bottom of page and the Text object.

-The parameters window for the array of experiment information parameters.

-The Open window for the Image object.

> Modifying the general page presentation or display

Click anywhere on the to-print page on the right button of the mouse to display the following menu

. Cut To remove the selected component
Format
i Format To define the parameters of the sheet of paper. (See Page Setup)

Zoom ¥ | Turn  To define the page orientation Portrait or Landscape

Zoom To define the display of the to-print page inside the Page window.
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> The Parameters function

On the printed document the selected parameters are laid out in an array. The Parameters function
permits to select the data parameters you wish to be printed and to define the style of the array.

To access this command double click with the left mouse button on the information parameters object
when defining the layout of the to-print document with the Page... command

» The Parameters window

data parameters.

List of the non printed

NS Parameters

Treatment
Filer
Spec. width

Objective
Canfiguration
Increment

Enter in the Title
field the printed
name of the
parameter selected in
the print list

Enter here the

number of columns
of the printed data
parameters array.

NSParameters tools to manage
the list of the data parameters to

print.

/

Print list: List of the
data parameters selected
to be printed.

Accumulation

Click on the Style button
to open the NSOptions
window to define the
design of the array.

Click on the OK
button to validate the
settings and to close
the window.

MTiHE
_? Caluran 3

1E>:posure

» Example of a printed data parameters array

Click on the Cancel
button to abort the
changes and to close
the window.

You will find below the data parameters array corresponding to the settings of the parameters screen
copy as it appears on the printed document.

Exposure is the

printed label for

the  exposition

Operator nf Laser TE4.8T Exposure 4 )
Sample acetylsalicylic acid | Power 1L 2w i@ sample Crating 950
Date 6-05-2003 18:55 Detector CCD4 Remark
Speciro 312.20 Accumulation z
— A - _J/
h'd h'd hd
Column 1 Column 2 Column 3
Remark:

A column contains 2 fields: the data parameter label and the data parameter value.

> The Parameters tools

ﬂ Add the selected data parameter to the print list.
ﬂ Remove the selected data parameter from the print list.

LabSpec5 manual
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ll In the print list move the selected parameter to the previous line.

LI In the print list move the selected parameter to the next line.

4.1.9 - Exit

The Exit command permits to close all the opened objects and quit the application.
To access this command select Exit from the File commands menu in the Main menu bar or click on the

Close icon in the upper right corner of the LabSpec5 main window.

N5 NGSLabSpec - Spectrum : sil N Close

File Edit Data Acg Service Cption Setup  Window  Help button

File
_’ Open... Chrl+o

menu Close

Save Chrl+s
Save Al

Prink... Chrl+P
Print Presview

Print Setup. .,

Page...

1 spectrum_Silicon-1015.tsf

2 =¥Image_benzen_1103_30_10.kvF
3 Wideo_siMire, bvf i
4 BOKU_schwanninger_3672. ksf | |

Exit _> . E::-::it | |
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4.2 - Edit menu

The Edit commands menu enables to exchange data between different applications and facilitates the data
analysis process.

To access the Edit menu click on the Edit button of the main menu bar.

ndo Chrl+Z

Tl i
= =rr I ==
[ reL Lt Rt S

iZuk k|4
Copy iZkp|HHZ

Pascka kel

Farrnat. .,

Undo (CTRL+Z)....... To undo the last operation.
Redo (CTRL+Y)....... To redo the last operation.
Cut (CIRL+X)....... To cut the active data object in clipboard.

Copy (CTRL+X)....... To copy the active data in clipboard. You can select the data format with the
Format... command.

Paste (CTRL+V)....... To insert the clipboard contents. You can select the clipboard format with the
Format... command.

Format..................... To select the Copy and Paste clipboard data formats.
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4.2.1 - Format function

This command permits to define the format of the data you export to the clipboard or and the one of the
data you import from the clipboard.
To access this command select Format... from the Edit commands menu in the Main menu bar.

> The Copy/Paste data formats selection

In the Copy format
column select the format
of the data exported to
the clipboard.

In the Paste format
column select the format
of the data imported from
the clipboard.

Copy/Paste Properties

— Copy format -
" Data v Data
O Tent 7 Text

+ Picture

- Pagzte format

Help

Cancel j

Click on the OK button to
validate the settings and
close the window

Click on the Cancel button
to abort the changes and
close the window.

* DataNative NextGen format. Can be used to create the exact copy of the data object.

» TextCreate the text spreadsheet of the active data object.

* PictureCreate the screen copy picture of the active window.

LabSpec5 manual
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4.3 - Data menu

The Data menu commands permit to activate a data object and to see the list of object of the active
window. This list is shown as a set of color radio buttons on the right pan of the screen.

To access the Data menu click on the Data button of the main menu bar.

gil You can activate one of the data object of the active window by clicking directly in
aspiz the list of the Data menu .

[iabag, Datas... Select this command to show the full objects list of the active window.

File. ‘Edit - Data, Acquisition  Opkions) Sstops Window! Help

On the following screen
copy the active window
contains 2 objects. (2
spectra) .

You can activate one
object also by clicking
on the colored radio
button.

| 0 BB R[S BB e |

Intensity (o)

Cancel |

Filter

IExtemaI La_:] I _vJ !?D prm |85 m

| Far Help, press F1 j3o00.28 1753 | A
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4.4 - Acquisition menu
The Acquisition menu commands permit to setup the data acquisition parameters.

To access the Acquisition menu click on the Acquisition button of the main menu bar.

Zustarm
Triager

RTD

Opkions
Auko save
Pl window
Dekectar
Autofocus

YWideo 4

Custom .....coevereserennes To customize the data properties.
Trigger...cecrescnresenes To set the properties of the manual trigger

RTD To set the properties of the Real Time Display acquisition mode.

Options......cceeeeeneecnes To set the parameters of the data acquisition, such as exposure time, binning,
acquisition mode and so on....

AUtO SAVe...crveresraresenne To set the ‘Save’ parameters to save automatically the data at end of acquisition.
Multi window........... To set the parameters to define the acquisition spectral regions.
Detector..................... To set the detector properties such as readout zone, gain etc.
Autofocus.................. To set the autofocus properties.

Video.....ccvreesecsencsenes To set the video acquisition properties.
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4.4.1 - Custom function

The Custom function allows to modify the data properties table during the data acquisition.

To access this command select Custom in the Acquisition menu.

< Custom Parameters
Yalue Ok |
Cate few 18 2005

- - Help
Operator mtc
Cancel

Sample f

[~ Open Dialog. when data acquistion started

To insert or remove properties click on the right mouse button and select Insert Row or Remove Row
menu item.

Check Open Dialog box to display this dialog automatically when the data acquisition process starts.
4.4.2 - Trigger function

The Trigger function allows you to set and customize the properties of the manual trigger. These
parameters are common for any acquisition procedure, except in RTD mode.

To access this function select Trigger item in the Acq menu.

You can select at which level of

In the Start or in the the acquisition procedure you
Sample field you Evert Message Use need to trig manually the data
have the possibility readout. \‘
to customize the Start |Click 0K ta start acquisition J:1 Thi 1d be J <t before each
: : is cou u e
:;?es:fe which will Sample |Click OK ta acquie data I data readout or for exemple ik P
case of mapping when
Help | Cancel ] .. .
positionning at a new sample
point.
Start ....coceeceneennnnesnns Select the corresponding Use box to see the associated message each time the

acquisition starts. You can customize the message text.

Sample ...................... Select the Use box to see the associated message each time when a new sample
point is selected for measurement. You can customize the message text.
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4.4.3 - Real Time Display function

The Real Time Display Properties Dialog window allows to modify the data acquisition properties for
the Real time CCD-image readout ( Detector image RTD function) or the spectra readout in

adjustment mode (. 12 RTD function Spectrum )

To access this function select RTD item in the Acquisition menu.

i~ Fropertiez

Image binning 1 v]
Image binning %" 1 v]
Readout zone Full -

Expozition time(zec] J'I

Help | Cancel ‘

Image binning X ...... Set the binning factor in the X direction for the CCD-image readout . This allows to
increase the acquisition speed and the signal intensity level.

Image binning Y ......Set the binning factor in the Y direction for the CCD-image readout. This allows to
increase the acquisition speed and the signal intensity level.

Image zone................ Define here the chip area you wish to load for the RTD CCD-image. You can
choice to read the full chip matrix (select Full) or only the chip area corresponding
to the spectrum readout area (select Spectrum).

Exposition time......... Set here the exposure time value in seconds.. This value appears also in the bottom
control panel.

Click on the OK button to validate the settings and to close the window

Hel . . . . .
A ................... Click on the Help button to retrieve the informations concerning the parameters of
this window.

w .................... Click on the Cancel button to close the window without validating the
changes.setting
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4.4.4 - Options function

The Acquisition Options window allows to define the data acquisition common properties.

To access to this window select the Options item in the Acquisition menu.

Exposition time................

Accumulation number ...

Data name.......................

Refresh time....................

Binning factor.................

# Options

Esposition timefeec] 11 s T

Accumulahion number |1 Help
[ ata name Test Foaey ‘

Refrezh time JEI

Binrirng fachar j‘l -
[rata mode Average -

Spike filker 0 -

Autofocus |Elff _vj+ 1IJ um
Scanning m

ze detectar [.ﬁ._uztm

...Set here the exposure time value in seconds. This value appears also in the

bottom control panel.

... Set here the number of times you wish to repeat the detector exposure.This is

useful in case of signal overflow. This value appears also in the bottom
control panel.

... Set here the data label and the default file name

.... This parameter is usefull in case of fast acquisition process or big data sizes.

The data display is not refreshed on the screen until this time is elapsed.

....Define the number of data points per spectrum.The signal intensity is

proportional to this value, but the number of data point (and spectral
resolution) will be reduced in the same way.

Data mode........................... This parameter is used in case of data accumulation ( Accumulation number
>1.)
m/Click on the down arrow icon to display the Data
ekl s hd mode list

Summa Then select how should be defined the final spectrum

LabSpec$ manual
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Spike filter

* Average... Final spectrum = ( Spectrum1+Spectrum?2+....+Spectrumn) / n

* Summa ... Final spectrum = ( Spectrum1+Spectrum?2+....+Spectrumn)
where n is the value of the accumulation number

Allows to remove or not the spike cosmic noise of the CCD detector.

Spike filter Jlilff vk/ Click on the down arrow icon to display the Spike

Autofocus

filter option list
D oubl . . .
Sii;;peazzu Then select if you wish to remove the eventual spikes

or not.

* Off........... No spike removal

* Double expo........... The cosmic spikes are removed by comparison of the signal values of
the different accumulation. So the accumulation number will be increased on the one time in
this case.

* Single pass.....o.eeeue This method allows to remove spike in a single accumulation
acquisition by analysing bans for sharpness and intensity. This algorithm has to used with
care . Very sharp Raman bands could be modified. Nevertheless this method works fine and
save time when looking broad bands as it is the case for Raman analysis of amorphous
materials or photoluminescence applications....

Allows to adapt or not automatically the Z position to obtain a maximal

Autofocus

signal level. The process is based on the detection of the laser beam
reflection.

Click on the down arrow icon to display the
Autofocus options list

|aff >+ [0 pm

In the + field you can adjust the shift valf—
Bef izt . .
BE;E{Z ZSEE‘E‘L‘?Q Then select if you wish to use or not the Autofocus

and at which step of the acquisition process you wish
to start the autofocus procedure.

L0 ) § SR The autofocus procedure is not used in the data acquisition process.

* Before acquisition. The autofocus procedure is applied before each data readout

* Before each point.. The autofocus procedure is applied at each new measurement point
positionning

* Shift value.............. The shift value allows to adjust the difference between the position
where the laser reflection is at maximum level and the one where the spectroscopic signal is
at maximum level .

Scanning...........c...ccoceveennnne. Allows you to define which scanning device has to be used to record a

spectral image the XY stage or the Scanner.

Scarning lstage vl Click on the down arrow icon to difptay the X
M scanning option list
S Then select in the list the wished device.
LabSpec$ manual 24



HORIBA OBIN YVON

Use detector ............. On systems with 2 detectors this option allows you to acquire data either from only
the current active detector or from the 2 installed detectors.
sbdstaatcr ! His T Click on the down arrow icon tg-display the

Use detector list.

ke

Then select the wished option.

S . . . .
R Click on the OK button to validate the settings and to close the window
Help . . . . .
................... Click on the Help button to retrieve the informations concerning the parameters of
this window.
Cancel . . . C oy
.................... Click on the Cancel button to close the window without validating the

changes.setting
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4.4.5 - Autosave function

The Auto Save window allows to modify the properties of the acquisition auto save option.
To access this window select Auto Save item in the Acquisition menu.

.I".

“ Auto save

[T Save acquired data

Farmat JLabSpEC [*.ngz] ﬂ

Folder Ju::"-.temp'x

W Year W Month W Day

File |Data

W Howr ¥ Min W Count JEI

Help ‘ Cancel ]

Save acquired data.............

Format

Select this box to save automatically the data when the acquisition process is
finished.

Select here the file format. The list of the different format supported is the
same one as for Open/Save functions.

Edit here the path where to save the files. Click on the J button to select
the folder in the tree structure.

Select this box to add the year number to the folder name.

Select this box to add the month number to the folder name.

Select this box to add the day number to the folder name.

Edit here the file prefix name.

Select this box to add the hour to the file name.

Select this box to add the minute to the file name.

Select this box to add the counter value to the file name. The counter is

modified each time the auto save function is called. But you can edit the start
value of the counter sequence.
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4.4.6 - Multi window function

The Multi Window function allows to set the properties of the acquisition in multi window mode. This
mode enables to record data automatically over an extended range with a defined integration time and
averaging. The extended range is covered by taking a number of individual single shot windows and
'gluing' these together..

To acces this Dialog select Multi Window item in the Acquisition menu.

' Multi Window

Fram Ta Time[]

s .

|_. J m ]
| | J
|_. J:.-:..: ]
| o e

bin overlaplpis] ]1 o0
SubPizel ]1 -

Lze multivindow v
Auto overlap v
Merge data v
Budjust intenzity [

Fieturn to first window W

Help | Cancel ‘

From.......... Edit here the value of the first limit of the spectral window in the current spectral unit. Select
the following | to activate the associated spectral window.

J I T, Edit here the value of the end limit of the spectral window in the current spectral unit. Select
the following " to activate the associated spectral window.

Time........... Edit the relative exposure time(in %) of this window. This value is used to compensate the
differences of signal level.

Min overlap (pix)..... Define here the overlap between the individual windows in pixels. A value of 50
gives generally good results.

SubPixel.....Selecting a value >1 allows to restore the fine shape features. The method is based on the
shifting of the spectrograph position on a distance less than the detector pixel size.

Use multi window.....Select this box to activate the multi window acquisition mode
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Auto overlap............. Select this box to automatically define the overlapping size.

Merge data................ Select this box to create one data object for each active spectral window. In the
other case a data object is generated for each spectral range corresponding to the spectrograph position.

Adjust intensity........ Select this box to adapt the intensity to the same values on the overlapping parts.
This adaptation is based on the linear shift of the data.

Click on the OK button to validate the settings and to close the window

................... Click on the Help button to retrieve the informations concerning the parameters of
this window.

w .................... Click on the Cancel button to close the window without validating the
changes.setting
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4.4.7 - Detector function

The Detector function allows to set the detector parameters. These parameters are common for any
acquisition process.
To access to this window select Detector item in the Acquisition menu.

« Detector E|

In this part select the

active detector and the ~Type '

readout mode (Spectru Sensor JﬂN_SE LJ w2

or CCD image) il J

Mode I Spectm Lj
| Cancel |
Sizes—

In the Sizes part enter the imm

readout limits of the P —

detector chip for the mode » '

selected in the Type part. |255

K {1024
- Optionz -

Set here the parameters [~ Highspeed ¥ High Gain

options attached to the D l-—

detector. I Offset d

]| I [73 FEE
» Type
Sensor.......cceeeeeeenne Select the active detector.
Mode.........cceeuveuennen. Select the readout mode. Single spectrum readout or CCD image mode.
> Sizes
Sizes Edit the readout limits of the detector chip. To check the readout zone run the
detector image Real Time Display, by clicking on the icon.

> Options

This section groups together parameters specific to the detector model. So this section appears differently
following the model of the installed detector. The most commonly used parameters will be described
hereafter. It is possible that some parameters does not appear if the correponding option is not available
on the on your current detector.

High speed................ Check this box to enable high speed data transfer.

High gain................... Check this box to enable high gain level of the detector amplifier.
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Offset ueuueeuecveccnnsnnens Check this box to subtract the dark current offset from the intensity values. Edit the
offset value to subtract in the associated field.

Temperature

Click on the H button to capture the current detector temperature.
The current temperature read is displayed in this field.

ﬂ [ == Lo set the temperature edit the value to reach
¥-_in this field and then click on the ﬂ button.

Check this box to have a continuous refresh of the temperature value.

4.4.8 - Autofocus function
The Autofocus ensures an optimal focus is reached before an acquisition.

This function allows you to define the properties of the Autofocus function.To acces to this window
select Autofocus item in the Acquisition menu.

- Autofocus @
- Option
Frarm ]457
v
Step lEi
Engine m
Internsity lﬂi

k. | Cancel |

From.......... Set the start position (in um) for the autofocus movement.
To...ocovvenne Set the stop position (in um) for the autofocus movement.
Step ........... Set the step size (in pm) for the autofocus movement.
Engine........ Allows you to select the device used for the autofocusing

+ Auto: The software select automatically between the Z-motor and the piezo following
the size of the movement defined by the From and To parameters.

« Z-motor: Force the software to use the Z-motor for autofocussing

+ Piezo: Force the software to use the piezo for autofocussing.
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o Z-motor & piezo. The software uses the both devices for autofocusing. A first approach
is done with the Z-motor. The research of the final position is then refined by using the
piezo.

Intensity..... Display the autofocus diode intensity.

.. Validate the settings and close the Autofocus window.
w.... Close the Autofocus window without validating the setting.

4.4.9 - Video functions

> Laser Position

The Laser Position window allows you to modify the position of the laser beam on the video image.
These parameters are used when the XY scanning is used during the acquisition process. To access this
window run the video preview and then select Laser item in the Acquisition/Video menu. Then you can
click and drug the laser position indicator with the mouse and the current position is refreshed in the
CenterX and Center Y field . It is also possible to enter the position directly in the CenterX / Center Y
through the keyboard.

Click the OK button to validate the settings
and Close the Laser Position window.

# Laser Position

Center |29.3515 ok, .
Click on the Cancel button to close the

Center |-19.8529 Help Laser position window  without
validating the settings.
Cancel

> Image Scale

The Image scale window allows you to adjust the scale of the video image. These parameters are used
when using an XY scanning device (Stage or Scanner) during the acquisition process. To access this
window run the video preview and then select Scale item in the Acquisition/Video menu.

+ ' Image scale

_:|_J ] Scale =Y

Move ztage o Scanner
corner and click

button
|
Size¥  |201.365 i
Size¥  [211.768 v

Scanner [

Reszet
Clear
Help

Cancel

Bl
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Corner points Move the XY stage to left-up rectangle corner and click on the point #1. Then move stage
to right-bottom corner and click on the point #2. Program will read the stage position and use this values
as rectangle sizes.

SizeX X size of the rectangle.

SizeY Y size of the rectangle

Stage Click on the button to modify video scale, used by XY stage. This operation
should be done for each microscope objective.

Scanner Click on the button to modify scanner scale.

Clear Clears SizeX and SizeY fields for stage joystick operation.
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4.5 - Option menu

The Option menu commands allows to select the default working unit and to convert the active data
object to the selected units when necessary.

To access the Option menu click on the Option button of the main menu bar.

| Dpkion
-
v ljcm
w MUl 'll
iznk
v iCnkfsec
izonverk
Unit........ Select this command to modify the default spectral and intensity units.
Nm...........e. To give the frequencies in nanometer (Wavelength spectral unit)
1/em........... To give the frequencies in cm-1 (Raman shift (relative wavenumber) spectral unit)
Cnt............. To give the intensity in Counts.
Cnt/sec...... To give the intensity in Counts per second.
Convert..... To give the active data object in the selected units.
Multi...... Select this option to apply any data treatment operation to all the data of the active window.
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4.6 - Setup menu

4.6.1 - Instrument

This function allows you to setup the instrument following the needs of the measurement and the
configuration of the instrument.

Actually this function is available only for the Aramis system.

To access this function select Instrument item in the Setup menu.

- Measure Localization - Pularization
= e Lazer Raman
- £ Wertical £
e  Horizontal © |
| " Circular £ N
[=5E
~Yisualization - i = Measure:
" VideoOn (+ Viden Off " Paint Maode
C Trino G € Tinadn £ FTE || = Line Mode
] | Cancel Help

The Aramis window is organized by functions: Measure localisation, Polarization, Visualization,
Measure. The software checks the presence of the different motors and their position. So if a motor is not
present the corresponding commutation appears in gray and could not be selected.

> Measure Localization
Retro ......... Select this oprion to set the appropriate mirror to capture the Retro-Raman signal

Macro 90....Select this option to set the appropiate mirror to capture the raman signal from the macro
plate.

Micro.......... Select this option to set the appropiate mirror to capture the raman signal from the
microscope.

External..... Select this option to set the appropiate mirror to capture the raman signal from the fiber
input.

> Polarization

* Laser

Vertical...... Setup the A/2 slide to obtain a vertical polarization of the laser.
Horizontal. Set in place the optical to retrieve the natural polarization of the laser.
Circular..... Set in place the A/4 slide to obtain a circular polarization of the laser.
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* Raman

Vertical...... Set in place the analyser on the raman path to polarize it vertically.
Horizontal. Set in place the analyser on the raman path to polarize it horizontally.
None........... Remove the analyser to have no polarization of the raman signal.

Scrambler option.
This option is available only if Retro or Macro90 or Micro option is selected.
Select the scrambler option to cancel any polarization effect on the raman signal.

» Visualization

Video on ....Set in place the camera beamsplitter.
Video off ... Remove the camera beamsplitter

Trino off.... Set in place the trino for the selected option.
Trino on
Trino FTIR

> Measure

Point mode Set in place the pinhole and the lenses assembly following the selected measure mode.
Line mode
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4.7 - Window menu

The Window menu commands permit to arrange automatically the data windows inside the main
LabSpec5 window.

To access the Window menu click on the Window button of the main menu bar.

Window Help

Cascade
Functions of the Tile

Window menu | >

arrange Icons

1 Spectrum ; sil
2 Image @ siMirez

List of the different 3 5plm @ SA037Z6C
opened windows. —P> 4 Model : lacts
5 Map : Red

v G Point : Sample
7 Score ; lactd

Cascade......cceeverrecrnnnns Cascade the windows so they overlap.
Tile Tile the windows.
Arrange Icons.............. Arrange the icons at the bottom of a main window.
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S - The control panel

The Control Panel located on the bottom of the screen contains divisions which are directly related to the
System configuration. This panel will show only the devices which are installed on the System. The
description below details all of the available sub-units.

“-Il_aser- 1 Filter: - ~Hole- < Slit 1 - Specto- 5
L=]) | L el wy a0 o] x |0 r
- % ﬂﬁﬂﬂﬂgj :';ﬂ%!:-ﬂ'-?m ¢ T 2 T
I - o2 L | B pm || [777 pm | | {772 1em| | ]T. SR .:.Z [0 J—_.
5.1 - Laser

Click here to open the list of the installed
laser.

Then select in the list the working laser.

If your instrument is full automated ( Aramis instrument) the set of the necessary optical pieces will be
automatically set in place so the chosen excitation light reaches the sample.

In case this part is not automated on your instrument a warning message similar to the following on will
be displayed.

Lab5pec

L] "'nf Flease select Laser 632,81
L

Cancel ‘

When everything is in place, click then on the OK button.

5.2 - Filter

Click here to reset the filter wheel and to set in

—Filter- place the filter displayed in the filter field.
% Click here to open the list of the 6 neugpal filters
installed.

D3 b
' Then select the one you wish to be in place.

Note: The reset function of the filter wheel is usefull when for any reason the selected filter is not well in
place or does not match the selected one.
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There are 6 neutral filters installed with the optical densities 0.3, 0.6, 1, 2,3 or 4.
[...] = no attenuation (Po)

[D0.3] = Po/2
[D0.6] = Po /4
[D1]=Po/10

[D2] = Py/100
[D3] = Py /1000
[D4] = Py/10000

5.3 - Confocal hole

Initialize the confocal hole by closing the

s ‘/ hole and opening it to the previous value.
o Aole -

Close the confocal hole L1

aperture. ] ﬁ

>
Set here the value of the Clozed unw'\ \?532 ;I;eacg:tic;zal hole to the maximum
aperture of the confocal p '
hole
5.4 - Slit. Initialize the slit by closing the slit and
it opening it to the previous value.
I

G
Close the slit.aperture. ﬂ
ead Open the slit to the maximum value of
Set here the value of the I HM | aperture.

aperture of the slit.

5.5 - Spectro
Initialize the spectrograph grating
position. Move to the zero order position
i~ Spectro & .-
Move the spectrograph = and then move to the position value
grating to the zero order ' previously set.

position. (Onm) \_ﬂ a

Enter here the spectrograph i
grating position value in
the active spectral unit.

Move the spectrograph grating to the
highest value of position.
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5.6 - Options

Click here to select one of the available

i i spectrograph gratings
My (1300 -

F w00
e r—_‘Test — Enter here a name for the next recorded spectral

data object. The software will add an incremental
number after the entered name.

Select the microscope objective.

5.7 - Exposure times

nter here the exposure time value in seconds to be used for
the spectrum and image RTD acquisition mode

4

C) 15 nter here the exposure time value to be used for the spectrum

and spectral image accumulation mode.
V) 12

Enter here the number of accumulations.

\
5.8 - Motorized XY/Z Table

Position of the different axis T Select the small blank box attached to
of the motorized XY/Z table. s 1'3 i each table moving axis to have the
Enter here also the position | 1|:| r~ orrespondlng position Valug refreghed in
ou want the table to be | real time even when moving with the
Y ;Z i':' I | joystick.

moved.

LabSpec) manual 39



HORIBA OBIN YVON

6 - The main icons bar

In this bar you will find all the icons correponding to the LabSpec5 main functions for the spectral data
acquisition, managing and treatment. These icons are grouped together by interest center.

* Tools for data management

* Data object display and information.
* Data acquisition

* Basic data treatment

* High-level data treatment

BEHEN |G H L) LBRLBRES ARNDLLHY BUR

e s s Sl i

Data management Display and Data acquisition Basic data High level data
tools information treatment treatment

6.1 - Data management tools

611-CUT &

Delete the active objects.

=

6.1.2 - OPEN 2

Open a data file.

6.1.3-SAVE [

Save the active objects into a file.

6.1.4 - PRINT =)

Print to the current printer the active to-print page. For more details please report to the description of the
print , print preview, print setup and page function in the File menu chapter.

6.15-HELP o

Open the LabSpec5 Help index.
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6.2 - Objects display and information

6.2.1 - Scale normalization &

Automatic scaling optimization of the active data objects.

6.2.2 - Intensity normalization

Normalize the current object in intensity.

6.2.3 - Pointers centering S |

s

Brings the pointers to the center of the active window.

6.2.4 - Data sizes :

This function reports the limits for each dimension of the active object in the following window.and
allows you to re-define it if necessary.

The Size field reports the number of the spectral points for the correponding axis.

Az Size From Ta L rit T
5 1993 1253337 [2187.25  iem
Extract
| | [ |34272  Lnl
Get
Cloze
Get feeeereeeennens Click on the Get button to update the limits of the current active displayed object.
el [ Use the Scale button to apply the limits to the active displayed object.
Estract . . .. . . .
——EEC——] .............. Extract the data included in the limits defined in the corresponding fields to build a
new object..

6.2.5 - Data parameters 4
A

Clicking on this icon displays the array of the acquisition parameters attached to the active object.
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6.3 - Data acquisition

e

The main purpose of this function is to offer a tool to allow you to adjust quickly the focus and the other
experimental conditions to maximize the Raman signal. Clicking on this icon starts in continuous the
following cycle:

- Acquisition in single shot window of a spectrum.

- Display of the acquired spectrum.
Each spectrum displayed replaces the previously displayed spectrum. There is no averaging or spectra
accumulation and no extended coverage possible. For this use the dedicated accumulation functions
described below.
The exposure time used is the one set in the RTD exposure time field in the control panel (Report to the
exposure time section in the control panel chapter).
The CCD pixels read are the one set in the Acquisition / RTD function.
To stop the continuous readout click on the STOP icon located at right end of the main icons bar. o)

6.3.1 - Spectrum Real Time Display

EE
6.3.2 - Detector image Real Time Display 1

The purpose of this function is the same as the one described in the pevious section applied to the CCD
image.

The CCD image is a 2D image of the intensity of each pixel of the CCD chip. Following the parameters
set in the Acquisition / RTD function this could be the full chip but also a part of the chip.

S .
6.3.3 - Spectra accumulation _=—_
Clicking on this icon allows spectra to be acquired with multiple accumulations and averaging and/or
with coverage over extended spectral ranges following the parameters setting of the Acquisition /
Detector function , the one of the Acquisition / Multi window function.

6.3.4 - Spectral Images accumulation -

With some suitable optional accessories installed on your instrument it is possible to acquire spectra in
function of one or a combination of some specific variable parameters to obtain for example XYZ
volume, XY mapped images, line (X/Y), depth (Z) , time and temperature profiles.

So the main purpose of this function is to acquire an array (3D for volume, 2D for map or 1D for profile)
of spectra, with each spectrum acquired with specific variable parameters like for example position, time,
temperature...

In all cases the result spectral array is saved in one single file for fast and easy data analysis.

The array below shows some examples of general possible applications following the different additional
optional dveices innstalled.

» Main examples of applications

Variable parameter Results Optional device used
X or Y position Line profile Motorized XY table / Scanner
Z position Depth or Z profile Motorized Z motor / Piezo
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Variable parameter Results Optional device used
Time Time profile No additional device
Temperature Temperature profile Heating/cooling stage

X and Y position

Map

Volume

Motorized XY table
Motorized XY/Z stage or

X,Y and Z positions

Motorized XY stage and piezo

6.3.5 - Spectral Image properties

.“'1
6.3.6 - Multi window il

Clicking on this icon allows you to define the properties of the spectra acquisition over extended spectral
ranges. You can also acces to this function from the main menu bar . Acquisition / Multiwindow. So
please report to this section for detailed explanations.

6.3.7 - Video

Clicking on this icon starts the continuous video image grabbing. To freeze the image press on the STOP
icon located at the right end of the main icons bar.

6.4 - Basic data treatment

6.4.1 - Baseline correction iﬁ

Clicking on this icon allows you to access the baseline correction functions.
The Baseline correction performs baseline correction of data by using a manual or automatic approach
and converts baseline profile to data array.

~ Dptions: 4]
Type  |Lines  ~+| 4
Degee |2~ Gonyet |
Attach  |Ma v M

Style 1— 71

I

Cloze

B
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» Manual Baseline Correction

The Manual Baseline Correction method is based on polynomial or line-segmented correction using
referenced points selected by the user.

To perform a manual base line correction :

1. In the Baseline window options select the baseline Type : Line Segmented or Polynomial.

2. In the Baseline window options select the Degree for the Polynomial baseline. -

3. Then in the left object associated graphics tools panel select the Baseline tool % Moving the
mouse inside the window of the active objet moves a cross pointer.
This enables you to add or move the points by clicking at the desired place.
By setting the Attach parameter in the options of the Baseline window to Yes the selected baseline
points are attached to the spectrum data.Setting this Attach parameter to No allows you to freely place
the points anywhere in the window.

4. In the Baseline window options use the Style list to select the style to display the baseline calculated
from the selected points.

5. Click on Sub button to subtract the baseline from the data.

This operation could be applied to multidimensional data set, visualized in one-dimensional curve mode
(1D)

FEeEH S W ¢ 3ol ERewES AWMU E | B

By
j"@l  Specirum: d03
A 5000 ;
I* Il
0= i Move this cross pointer and
0o _ ' click at the wished place to !
£ = define the baseline points
i e . Se— o— A—— —
o | |
i i '\
& :
Q < Baseline
Q i E Optiong————— e &
i ! ! .'_ _ ! Ill.T_'r'DB m Clear |
" 12 Degree I2 :]' Ebn’vertl
3 Altach Yes e Auto |
4|Sl}'|e | vl Fit |
Laser Filter = --Hc;ic Shit ~ Spectio = D&l
’ !.’.j ﬂ EI ﬂ, !Zi |.".i \ IW Help |
=] =) (B ) = g 3] Q,’I"m:|D Closel
=l - BN EE um || [777 . ‘ [777 Trem| (& [Test
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» Automatic Baseline Correction.

The Automatic Baseline Correction
(non-peak) of the data. The algorithm
points above the baseline are
continues until the fitting errors are
number of points is not changed.
The baseline is then automatically
is displayed.

To calculate the baseline without
> Baseline Conversion.

The Baseline Correction operation
operation allows the baseline trace to

Click on the Convert button to start

» Baseline Clear.

The baseline is displayed
in the selected style.

Click on the Clear button to remove the baseline points.

. D
6.4.2 - Data correction 4=

iteratively fits a polynomial to the baseline
starts with a full set of data points. The
removed and the fitting procedure
less than the predefined value or the
Click on Auto button to start the procedure.
subtracted from the data and the finalresult

subtraction, click on the Fit button.

replaces the data by the baseline trace. This
be saved as a data file for future retrieving.
this function.

The Data correction function allows you to modify all the traces of a multidimensional data matrix.
Some of these operations require an additional spectrum as a second parameter of the operation.

« Correction
i~ Corrector — e
g Zerm
ﬁg 4 Get
&
& Diel
=
5 B
Sub
Gl cfi _,-\__--J'——- e il kil
! 1 ! 1 B
S 2000 Carr
Raran Shift (era )
Help
i~ Limitg e
From |B0B.372 To 11 A51.65 v
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Noma | .. The Norma button normalizes all the traces to same area value (100).

280 | . The Zero button moves all the traces to the minimum intensity level.

Get | The Get button takes the activated spectrum and put it in Corrector frame. This

data object will be used as parameter.

s The Del button removes the Corrector spectrum.

S - The Sub button subtracts the Corrector spectrum from all the traces.

Ml The Mul button multiplies all the traces by the Corrector spectrum.

L N The Corr button subtracts the Corrector spectrum from all the traces. The

intensity of the Corrector is multiplied to fit the intensity of the trace

Limits Select the small blank box if you want that only a part of the trace is used for operation. This
parameter is used for Norma and Corr operation.

—

Lirits \
From  [506.37 To  [155165 v

From and To Edit these fields to modify the limits of the selected region.

Sy
6.4.3 - Filtration &~

This function allows linear and non-linear smoothing and calculates the derivatives of first and second
degrees. The Linear Savitsky-Golay smoothing and derivative computing are based on the convolution
approach which performs a least squares fit of polynomial.

The larger is the Size value and the lower is the Degree value result in a higher smoothing effect.

> Degree

< Filtration
Set in this field the degree of the polynomial. — |

bioh

The lower is the degree the more intense is the 2ot
Degee |4 -

smoothing effect . Derl

> Size sies J :]v Der
Set in this field the number of the adjacent data Medi
edian

points to be used for the calculation.

The larger is the Size value the more intense is the Sl

smoothing effect Cloze

Dl

ﬂ] .............. Click on the Smooth button to perform the Savitsky-Golay smoothing.
ﬂJ .............. Click on the Der 1 button to calculate the first degree derivate.
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ez |

Click on the Der 2 button to calculate the second degree derivate.

M .............. Click on the Median button to apply the median smoothing. The Median
smoothing is a non-linear data filter method.

T

6.4.4 - Fourier transformation

The Fourier Smoothing is based on the direct Fourier data transformation, applying filter and
apodization function and inverse the Fourier transformation. The dialog window shows the real and
imaginary Fourier functions and allows you then to select the smoothing property.

# Fourier

i~ Faurier [Data =
x103
— i Help
1 Cancel
500 1
=
g =
P
o Ww
-500—
I ' l ' I
0 50 1a0g
fau
— Options -

Lirnit |50 Go| dpod, (Mo +| Fiter |MNo -

> Limit — Enter in this field the position of the cutoff point in %. This parameter defines the smoothing
factor 0 — full smoothed, 100 — no smoothing. Click on the GO button to apply the value or drag the
pointer to select the Limit visually.

> Apod — Select here the type of the apodization function with apodization value reaching zero at a
Limit point.

N oo No apodization function
| )11 T Linear function

N 10| Parabolic function

(6 (S ——— Cosinus function

> Filter —Select here the type of the filter function.

A1) 1 (s No filter function
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Traffic eeeeeeeeeeeeeeeenee Traffic function

6.4.5 - Arithmetical operation *¢

The Math Operation can be used to apply commonly used mathematical formulas to a data object.

¢ Math X

T oo |

T ot |

i = _ e |

Func 2 J:.:+_-,| M
Help

o |

» Addition of a constant value
Enter the value in the Const+ field and click on the Const+ button to add the constant value to the data
object.

> Multiplication by a constant value
Enter the value in the Const* field and click on the Const* button to multiply the data object by the
constant value.

> Application of a complex mathematical function

Enter the mathematical function in the Funel or Func2 fields and click on the Funcl or Func2 button to
apply the correponding function to the data object.

The mathematical formula can include basic mathematical function (+, -, *, /, *), negating, pow, log, exp,
sin, cos, asin, acos, atan, abs, sqrt, step.

For example the “sin(a)” formula replaces the data intensities by sinus function.
The “1000*log(abs(x)+1)” converts intensity to logarithm scale.

The following rules are applied for the variables names:

— the variables a, b, ¢, ... correspond to the values of 1,2, ... data axis
- the x and y value are consider as intensity of data objects.

» Merge function

Click on the MERGE button to multiply data objects into a single.

LabSpec5 manual 48



HORIBA OBIN YVON

6.4.6 - Peaks and Bands operations It
> General presentation

The Peak Fitting operation performs a peak search and curve fitting for a single data trace or a
multidimensional data set. The following list of capabilities is offered by the program:

- Manual or Auto peak selection routine.

- Gaussian, Lorentzian, Polynomial and other mathematical formulas for peak.
- Fixing peak parameters during curve fitting operation.

- Mapping peak parameters for multidimensional data matrices.

¢ Peaks X

~ Optionz- | Search
Shape Gauzsloren = A
|

~Search-
Levellz] |11

o |
Sizelprt] |13 =

~ Fitting- - Vars... J
|

[teration 11 ]

Skip (prit) |0 Sha
pES...
Error
Help

[~ Bazeline

Click on button on the right side of the Peaks window to call one of the following functions:

SeACh | Calls the peak auto finder procedure.
CETE | Approximates the height and width of peaks without fitting.
LI D Calls the peak fitting procedure.
CRar | o Removes all peaks and baselines of the data.

Comvart | o Converts the sum shape of peaks and baselines to data trace.
ﬂ ................... Opens tables showing the parameters of peaks.
ﬂ .................. Opens the tables of variables, used in curve formulas.
ﬂ .................. Opens the display properties dialog.
m .................. Opens the display properties dialog.

LabSpec5 manual 49



HORIBA OBIN YVON

> Peaks selection
The Peak Edit Properties control the automatic and manual peak correction.

+ Peaks
Select or edit Peak Shape control to modify the
peak curve shape. This value will be used, when _{| |~ Optiors-
you insert a peak manually or call the peak Search =
procedure : Shae L ot \5
[~ Search-

Edit the Search Min Level box to modify the :
. =y Levelz) |11
parameters level for the peak Search algorithm.

—
A

Edit the Search Size box to modify the number of Slzelpnl ]13
points for the peak Search algorithm. — | ==

— Fitting

[teration i'l ]

Skip [prit) ;n

Error

1“‘ Bazeline

To select and define peaks manually use the following icons on the left graphics tool panel.

........................... To add or move a peak
........................... To adjust the height and width of a peak.

............................ To remove a peak.
+ Adding or moving a peak.
Sdpecinme B2’
X Click on this icon.
Then move the cross at the desired

position. A peak will appear in
function of the settings of the SHOW @
8
®
&,
$

OST " ETFES

properties.

Intensitsr {ont)
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+ Adjusting peak height and width

X Click on this icon to define or modify the height and width of the selected peak.

Peak height modification

Move the mouse on the height of the peak to modify. When the following symbol appears click and
drag the mouse to the wished height.

Peak width modification.

Move the mouse on one of the sides of the peak to modify. When the following symbol or
| ﬁ‘ appears click and drag the mouse to obtain the wished width.

+ Removing a peak

& Click on this
icon to remove
peaks.

¢ Spectrum : d03 *

fEx

Move the mouse
pointer on the peak
you wish to remove.
When the following

symbol EI appears

click on the left =
mouse button. The .
correponding peakk
is removed.

SO EFES

z
=
2
e

Raman Shift (ora

> SEARCH function

The Peak Search operation performs a search for peaks. It iterates all the points of the data trace to
localize the local maxima.

i~ Search

In the Search Size field define the number of points in the .
maximum locality. Levell%) I11

—

]

The Search Level parameter controls the minimum intensity Size(prt] 113
value of local maximum. | ==

> APPROX function

The Peak Approximation procedure can be used to estimate the initial values of the peak parameters.
The height and width of the peaks are modified by this method; the other parameters are not changed. The
height of the peak is replaced by the intensity value at the peak position point. The width is replaced by
the difference in position of the peak and the intensity value of the nearest point, less then half of height.
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> FIT function
The Peak Fit algorithm uses the Levenberg-Marquart method of non-linear peak fitting. It is based on the

iteratively adjustment of every peak parameter to attempt the minimal value of Xz. The basic problem of
such an approach is that it can be the multitude of possible solutions and depending on the starting values
of peak parameters. To avoid such a situation you should select the position and shape of the peak as
much to presumed solution as possible.

The Approx procedure allows the initial values to be adapted to the intensity of data points around the
peak. The other way is to fix the parameters which are known. You can select the maximum number of
iteration to limit the treatment time. Increasing the number of skip data point allows to check quickly the
convergence of the algorithm and the quality of the initial value selection.

- Optians: | Search

Edit the Iteration field to modify the maximum iteration. Shape (sl e . T ]
Edit the Skip point field to modify the number of data ~Search- : Fit J
points skipped from the fitting procedure. Leveliz)  [11 = J

eal

—

The Error box displays the error value, as distance : Ii Earwait
between original data and curve sum of all peaks and el 13 J

baselines. This value is named usually as 2. —4 | Peaks..
i~ Fitting- o MWars. J

Check Baseline box to fit baseline together with the peaks. i
10

Shiow... J

@ iﬂ Shapesz..
|

—t Pl Baseline

Help

Cloze

Ldjd

» PEAKS... function

The Peak Table dialog shows the peaks parameters. You can edit each of these parameters, add new
peaks and remove existing ones.

F Mep| s (Fiw Map| w Fix Map| g [Fix Map| Fomua |
1 57Esh T [ 200 T e ir GauzsLoren()
I A 570561 [~ [ il 05 [ [~  GaussLorer() Cancel
3| 1B "eZma - Tl il 05 [  GaussLoren()

P, a, w... columns show the values of the peak parameters. The number of the parameter depends from
the peak shape formula.
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P ——— peak position (cm-1)
Buvreereeereeeesreereeneannens amplitude (max. Intensity)
Woateetreeennreesneeeneeennneenes full width half max (cm-1)
USSR gaussian contribution (1= max)
S terrreere et e integrated area of band
Fix Check this box to fix the parameters during the fitting operation
A7 E:1 1 Check this box to display the map of the parameters. This option is available for
multidimensional data set.
Formula ........ccccenue. Shows the peak shape formula.

Click on the right mouse button and select Insert row or Remove row menu items to add or remove
peaks.

» CLEAR function
Remove all peaks and baselines of the data.

» CONVERT function
Convert the sum shape of peaks and baselines to data trace.

> VAR... function

The Peak parameters Initialization dialog enables you to select the initial value for the peak
parameters. The parameters are displayed in a spreadsheet. To move inside the spreadsheet use the arrow-
keys.

+ Variables

e
p+10

100 Cancel
mnasy

masy

sy

1

Edit Name column to select the peak parameter variable name. This name must be the same as in the peak
shape formula. To edit the name double click on the variable name.

Edit Init column to select the initial value of the parameters. You can use number or mathematical
formulae with the the following predefined variables:

) QTS x coordinate of the peak insertion point
Voreereerenee e e nieenieens y coordinate of the peak insertion point
111711 ). R low limit of x data axis.

1117:0'0 SRR high limit of x data axis.
mMiny........ccooevvveenenns low limit of y data axis.

1117:). 2SR high limit of y data axis.

(1 ) R maxx-minx

(1 ) TSR maxy-miny
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Edit Min and Max columns to select the parameter limits. These limits will be used during the fit. You
can use number or mathematical formulae in the same way as for Init.

> SHOW... function
The Peak Fitting Show Properties allows you to customize the display of the fitting results in the data
object current window.

Check Show box to display the following items.
Click on the Style control to modify and select
the style of the selected item.

- Options- alf
Shile Shiow :

Text ........... shows peak label. _ Help
Arrow ........ shows the peak arrow stick. e [18Tines New e x| ¥
Shape ......... shows the band shape. Anow ————= ¥ m
Sum ........... shows the result shapes of the all Shoks —

bands.
Res ............. shows the residual between the Ll S

original data and band sum. Residusl | ———— «| T
Check Use data style to control the use data color TR auox].[1 ]
when drawing the peak tick and label. In other W Uss data stle
cases the Arrow and Text styles will be used. v Shape multicolor
Check Shape multicolor box to personalize the v ttach araw
color for each peak.
Check Attach arrow box to show the peak label
tick immediately above data shape.
> SHAPES... function
The Peak Shapes allows to customize the shape of the peak.
Edit the shape Name in the left [EEETET 3
column. This name will then
appear in the list of the available Name Farmula
peak shapes of the Shape item in JLett | stepla-p)/ 1 +[=p ] (-p) (o)) Help

the Peaks window. ] |
Edit then the corresponding l
mathematical Formula in the l
Formula column. Some of the ] I
| |
| |

Cancel

formula parameters have a
predefined meaning :

« a peak amplitude

+ w peak width

» p peak position

Then use the peak parameters initialization function (VAR... button) dialog to set or modify the initial
value of these parameters.
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6.4.7 - Profile &=

The Profile operation performs a visualization of the vertical or horizontal profile of an image.
To start a Profile operation :

+ Load an image and activate image display window.
« Select cross line pointer by using window menu Pointer item.

+ Click on the following icon E¢ to open the profile window.

£ Profile

i~ Prafile

1000 =+

Intensity (cnf)

1 {jurm)

Choose Hor or Ver control to select between horizontal and vertical profiles.
Click on the Corr button to replace the image profile. This operation can be useful when you apply some
operations to the profile (for example smoothing) and then you want to set data back to the image.
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6.5 - High level data treatment.

L3
6.5.1 - Mapping ok

The Mapping procedure generates a map by using the signal intensity in the selected spectral regions. Up
to 4 maps can be displayed when you load or acquire the spectral image: the first three are the average
signal intensity and the last is the signal ratio.
The selection of the spectral region is done with the Red, Green or Blue pointer in the spectral image

window.

Check Use box to generate
the corresponding map.

Check Base box to subtract
baseline.

Check Green/blue box to
generate the map of the
corresponding ratio.

Check Spectrum box to see |

the spectrum of the selected
data point(s) .

£ Mapping
Opkans
Use From To
MoV [a19.482 214734 K
Green v 11 297.04 135536
Elue v v {455.1 46 |5E0.307

Green/Blue) [w

EIK|

Convert | Caricel |

| You can edit From and To

fields to adjust the limits of
| the spectral regions.

Click on the Correct button
to modify data on the
selected data point(s).

mapping window.

close the mapping window.

this window.

validating the changes.setting

................. Click on the OK button to generate the map following the settings and close the

Click on the Convert button to convert the current map into spectral image and

................. Click on the Help button to retrieve the informations concerning the parameters of

................. Click on the Cancel button to close the Mapping window without without

LabSpec5 manual

56



HORIBA OBIN YVON

e

6.5.2 - New spectral profile

The Spectral Profile operation allows you to create and modify the all traces of spectral profile data
matrix.

¢«  Spectral profile

H

i
M arme Wl
Add
[nzert

Delete

Help

Pl

Cloze

New ... Click on the NEW button to take the activated spectrum and create a new spectral
profile . Edit the Name box to define the spectral profile.
&dd . . .
............ Click on the Add button to take the activated spectrum and add it to
the end of spectral profile.
Insert ... Click on the Insert button to take the activated spectrum and insert it to the spectral
profile, selected by cursor pointer.
Dilate | eeeesenens To removes the trace selected by cursor pointer from the spectral profile.
Help |- Click on the Help button to retrieve the informations concerning the parameters of
this window.
Cloze  |eeeeereeen. Click on the Cancel button to close the window without validating the changes

setting.
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6.5.3 - Modeling a&
Click on Modeling icon to open DCLS Dialog.

The Direct Classical Least Squares finds the linear combination of data from pure components making up
the combination that most closely matches the original data. This operation, applied to all traces of the
original data sets, yields the maps of each component. The multiplicative constants used on the pure
spectra are proportional to the concentrations of respective components. The difference between the
sample and the linear combination is the residual spectrum, which could be useful for diagnostic
purposes. DCLS requires the spectra of all components presented in the sample, and assumes that this
spectra are not the changed when the component are mixed together. To apply DCLS mapping :

« Activate the multidimensional Data Matrix

Click on the s icon to open DCLS Dialog.

" Model

Activate the Spectrum window - Properties : New

Enter Model Name. Mame ;

Click on New button to use the spectrum as Model. —| |

Help

[ Allow negative scores

If you choose Allow negative scores check box, the program [ Show error map
will use any type of combination, even if this combination | °
includes negative values. Such a combination corresponds to
negative concentrations that do not have a physical sense. This case often happens when the set of
component are not completed or a contribution of some components is near to zero.

Cloze

el

Select Show error map to see the distribution of the error.
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7 - The graphics tools panel

The graphics Tool Panel on the left part of the screen allows you to modify the data appearance and run
visual edit operations. Following the type of the current data object the tool panel is updated.
You will find hereafter a description of all the tools available.

7.1 - Activate the pointer [}

The Pointers permit you to check the coordinates of the data matrix axis at the desired location.

To activate a pointer click on the pointer icon in the graphics tools bar (left bar).

To change a pointer position click with the left mouse button and drag to the wished position. The current
pointer coordinates are displayed in the status bar at the bottom of the main window.

If the current active data object is a 2D spectral image click on the SpImRed, or SpImGreen or
R SpImBlue icon to activate the corresponding pointer.

In any case to initialize the pointer position (move to the window center) click on the pointers centering

F£ | icon in the main icons bar.
T

LabSpec$ offers also the possibility to customize the pointers display by using the pointer function of the
Window context menu.

7.2 - Integral M

The Integral Operation can be used to calculate the area of a spectrum peak. Click on the Integral icon
in the graphics tool panel to open the Integral Operation dialog.

# Integral

[ Walues - 1| Apply 1

From |1200.55
Copy
Tao 1350.14

=—— Help
Tap 2101.64 J

Eottarn Eﬁﬁ—_ w

Full 46206
Farmat & Digits vi

< Paint : Sample

Intensity (cntisec)

Bottom

4 ~ Stule
) ! . i . Line — v]
500 1000 _
Ranam Shift (er) Fil -
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From.......ieeeeenne Edit here the the low integral limit. You can also drag the pointer to select the limit
interactively

To Edit here the high integral limit. You can also drag the pointer to select the limit
interactively

Top Shows the integral result without baseline.

Base Shows the baseline value

Full Shows the Top + Base value.

Format...................... Select here the number of digits to display the result numbers

Line Click on the control to modify the color and line style.

Fill Click on the control to modify the color and style of the background.

Click on the Apply button to apply the From, To, Line and Fill settings.

Co ‘ Click on the Copy button to copy the values to the clipboard. This is usefull to retrieve these
P* 1 values by using Copy/Paste functions from other softwares.

7.3 - Baseline 4 #4

Use this tool to define the points to build the baseline to perform a manual baseline correction.
Moving the mouse inside the window of the active objet moves a cross pointer. This enables you
to add or move the points by clicking at the desired place.

M Use this tool to remove some points of the baseline. Move the mouse inside the window of the
active object on the point you wish to be removed. When the square cursor appears click on the
left mouse button to remove the wished point.

7.4 - Manual contant multiplication to data 0
Use this tool to multiply by a constant the active spectrum. This a manual method using the mouse. Press
the Mul const icon and move the spectrum up or down to the wished position.

7.5 - Manual constant addition to data [*
Use this tool to add a constant to the active spectrum. This a manual method using the mouse. Press the
Add const icon and move the spectrum up or down to the wished position.

7.6 - Remove ‘spike’ [

Use this tool to remove no desired points like spikes , cosmics rays,...

7.7 - Correct data shape =

This tool allows you to modify a spectrum by correcting each point of the spectrum.
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78-Peak tools & T &

£ Point : Sample

This tool allows you to display the wavelength or the

wavenumber of the selected peaks. The label is displayed ]
following the style parameters set in the show function of the
Peaks and Bands operations function. This tool is also used to
define manually peaks for the fitting operation.

350

300

Intemsity (cntfsec)

250

e Use this tool to define or modify the height and width of 200
the selected peak for band fitting operation. Report to the T : e
Peaks and Bands operations chapter for details concerning the st Sl )
use of this tool.

b4 Use this tool to remove displayed peaks label or to remove bands selected for bands fitting. For
details concerning this tool report to the Peaks and Bands operations chapter.

7.9 - Linear shift of the scale limits %

Use this tool to move the vertical or/and horizontal of the active object.

7.10 - Zoom scale
This tool allows you to select the part of the active object you want to zoom. Press the left mouse button
and draw a rectangle to define the wished part.

7.11 - Intensity shift £

Use this tool to adjust the intensity scale of the active data object.

7.12 - Axes

Use this tool to position and dimension the axes rectangle inside the active window.

/ Point ; Sample E] When clicking on this tool icon a dotted
rectangle is displayed.

To re-dimension the rectangle:

Move the mouse pointer on one of the
selection handles until to have the size

E
=
8.
&
&
b

pointer: Ior e .Keep the mouse button
pressed and move the selection handle to
modify the size of the axes rectangle.

To move the rectangle:

Move the mouse pointer anywhere inside
the rectangle . When the moving pointer
4—}» appears press the left mouse button and drag to move the rectangle inside the active window.
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7.13 - Change 3D axes.
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8 - Window context menu

8.1 - Format

You can open Vizualization Format dialog by selecting Format menu item

- Style

Internal “:l_;'_j w
Extermal |I:|_"_i

Caricel
=

Dimenzion |2D _:_j

W se scroll scale

Mode | Single

[ Always show scroll bars
I™ One data per view
I~ ¥ scale = scale

Intens ]12 153

- Scale-
From Ta Freeze Auto Frop Log
Hor |20 120 = = 1 I
Wer |80 |250 I~ ¥ I I
[ = 1 [

> Internal Click on this control to modify the color and style of the data field background

> External Click on this control to modify the color and style of the window border. Usually it is where

the axes are painted.

> Mode Select one of the following data display modes
Single.......... only activated data object is displayed
Overlay...... all data objects are displayed on the same place
Tile...cooeeeenes data objects will be shown in the separated rectangles
Projection.. trace of the activated data object will be shown in the separated rectangles
Trace.......... single trace of the activated object will be shown.
Use the right scroll bar to change the trace.

> Dimension
1D /2D 3D

> Use scroll scale check this box to use the window bottom and right scroll bar

> Always show scroll bar check this box to always show the scroll bars, when the visual zone is large

then the data limits.

> One data per view if you check this box, the next time data is displayed a new window will be

created.
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> Y scale = X scale uses the same scale for both axes; useful for 2D image presentation.

Scale .......... shows the scale properties for each of the window axes.
From .......... value of low axis limit
180 oo value of high axis limit
Freeze ........ fixes axis limits.
The scale will be skipped when normalization function is applied.
AUto ....cee.e. enables auto scaling when data object axis is changed
Prop ........... enables proper scale limits for each data object.
Log ............ enables logarithm scale for the axis

8.2 - Norma

8.3 - Colors

The Colors Dialog enables the image color properties to be modified. Such properties are used when
displaying images.

To access this function click on the right mouse button and select Colors menu items.

' Colors

Select

here the e el :
active color frame —t» CE O E o
W Gieen | | — HE C BE C ES Qp
E CEn

v Fed

5 Blus . Cancel

- Contrast/Brightness:

>

I~ Neg = “ Adjust Contrast an%ightness

> ¥ by moving the scale Br cursors.

In the Colors frame you can turn on/off Red, Green or Blue color.

To make image negative choose Neg check box.

In the Palette frame select one of the following styles:

True color................... All colors are displayed without modification
Black and White.

False color.

GIeen ....coeeveeeeveeenennns Yellow scale.
Red .oovveviiieie, Magenta scale.
Blue ....ccooevvveiies Cyan scale.
Blue ..cooooviiiiiiies Magenta scale.
GIreen ....ccoeeveeverevennnnns Cyan scale.
Red ..o, Yellow scale.
Blue ...cccoooovveeiiies Green scale
Red ..o, Green scale.
Blue ..ccooooiiiiiis Red scale.
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8.4 - Axes

The Axes dialog allows you to customize the appearance of the graph axes.

£ 5plm : Pharma

Labels — g ayan Shift (e TOP Axis
st

500

400 600 1000 1200 1400
4 1000 ~1000
:E e e . ! - ! ; s e
o 900 ——— GRID =900
B — | | H— g
T3 00 — =200
i m — S —— g
£ ! x _ | | I R 2
E 600 —00 i
z - g
£ :

|
Fet

RIGHT Axis

i WPHI-WW‘H‘ =T - i < . , —
auJN rjnln_v\ ,zm'n o 1=2"au Cam

Ticks © Values ' FamanShift (o) 'BOTTOM Axis

Intensity

As shown on the picture above there are 4 axis. The Axes Dialog allows you to define independently each
component of each axis. You access to the Axes Dialog by selecting the Axes item of the window

context menu.

7 Axes [gj
> Options
- Optionz-
. .o . Ticks Grd Values  Labels
Tick ...... Check the box to enable the painting of ticks.
Top H E [ 4 |
Grid....... Check the box to create a grid for tick levels. Lt W ¥ M W]
Values .. Check the box to enable the painting of e R R
number values associated to ticks. Fe el B
) Intenzity [ | B |
Labels .. Check the box to create an axis label and e

enable customization of the axis labgl.ln the 0 — e
Labels blank field enter the text you wish to be -
b ain grid - Labels ]12 Times ']

appeared for the corresponding axis.
Sub gnd - Ticks ]7 v]

30 Lock W

Help ‘ Cancel ‘
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> Style
Frame ........ click on the control to modify the color and style of axis edge.
This parameter is used for a non 3D look.
Main Grid .click on the control to modify the color and style of the main grid
Sub Grid ... click on the control to modify the color and style of the sub grid
Values ........ click on the control to modify the values font.
Labels ........ click on the control to modify the labels font
Ticks ..eceeenes click on the control to modify the color and style of the ticks.
3D Look .... Check this box to enable a 3D outlook for the edge

8.5 - Graph

This function allows you to customize the appearance of 1D dimension displayed data objects.( Spectrum
or Spectral Image)

8.5.1 - Spectrum

If the active object is a spectrum selecting Graph item of the window context menu opens the spectrum
Properties dialog which allows you to modify the display properties of the spectrum.

> Select one of the Style controls to
display spectrum as a set of Lines,
Points or Bars. Style & L'r_"ﬂ gl

¢ Spectrum

- Optiong -

E i[ﬂﬂﬂh Help |
> Click Line control to modify the color, Eirie j—L_i B |

thickness and line type.

* Point : Sampl L E)X
oin ample =L = < Paint : Sample

Intemsity (cnitizec)

400~

300

200

Intenaity {ontisec)

! L
500 1000

Points

< Point : Sample

Intensite {cntfsec)

Farnan Shift (el . Rarman Shift {or 1
Lines |

<] e

300+

2 1
500 1000
Raman Shift (ordy

LabSpec5 manual

66



HORIBA OBIN YVON

8.5.2 - Spectra

If the active object is a spectral image selecting Graph item of the window context menu opens the
spectra Properties dialog which allows you to modify the display properties of the SpIm object.

 5plm : Pharma I:“EIE|

_—
L)
%

=

=
£

5
=

fln

| - |
500 1000
Raran Shift (crw 1)

+ Spectra
- Options -
Line
Fill

Lines

| ‘:J Help I
“:llj Cancel I
No =]

> Click Line control to modify the color, thickness and line type.

> Click Fill control to modify the color and fill style of the filled zone.

> Click Lines control to select the representation mode of all the spectra. You can select to display All
the spectra , leave the software to display automatically the necessary spectra so it is readable, or as
shown on the picture above not to display all the spectra.

8.6 -

Pointers

The Pointers dialog allows you to customize the appearance of the pointers.You access it by selecting
the Pointers item of the window context menu.

> Click on the Style control to choose one of the following pointer types:

Line ...... single vertical line.

Cross .... vertical and horizontal lines.

Level .....vertical and horizontal lines.

The position of horizontal line corresponds to the data
intensity value.

Double...two vertical lines.

Rect....... rectangle.

> Click on the Active control to choose the line style, when
the pointer is selected (you can drag pointer with the
mouse).

« Pointer

- Ophions:

Shyle
Selected
Deselected

Tranzparent

Help

Cancel

> Click on the Hidden control to choose the line style, when the pointer is deactivated.

> Check Transparent box to draw a pointer in transparent style. In such cases the image of the pointer
is superposed with the window background.
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8.7 - Image
The Image Properties Dialog enables to modify the appearance of the images data objects. To access
this dialog, select Image item from the window context menu.

> Select Style mode, to make or not a linear 7 Image [E|

interpolation of image intensity along X and/or Y

axes. - Options-

& E i Canicel

L |
Smoothed  along  column Shyle ﬁ &]

Calar I -
Unsmoothed — - g m :

Smoothed along —ppi* E (™ m

line T

Smoothed along diagonal

> Click Color to modify the image color. This color will be used, when you select overlay mode for the
data display.

8.8 - Scale bar

The Scale Bar Properties dialog allows you to modify the display properties of the scale bar and its
associated legend of the 2D presentations. To access this dialog, select Scale Bar item from the window
context menu.

< Scale Bar

> Click on Line control to select the bar border style and
color of the scale bar. e
> Click on Fill control to select the sacle bar filling style L= | =l =

and color. Fill (P—— v] Cancel

» Click on Font control to select they the scale bar legend o 14 Times v ]
font properties Colar r =

» Click on Color control to select scale bar legend text
color.

- Optionz-

Scale bar legend

Scale bar
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8.9 - Image3D

The Image3D Properties Dialog enables the modification of the appearance of a 3D representation of
the data object. To open this dialog, select the Image3D item from the window context menu.

> Type Select between polygon and gradation

display mode. ~Shyle e i
(" i)
> Gradation Select the axis which defines the Type C@ 0 Help |
direction of the the color gradation ;
Gradation @ = [~ % [~ 2 Cancel |

» Click on the Color control to modify the
polygon border style and color.

Colar ] >
Fill I -

» Click on the Fill control to modify the internal
polygon fill-style.

< 5plm : Pharma

1~ Style
R "I
Bradslion [ X [ [ 2 | i |
ot |—— =]
Fil [ - |

=
=
=

L
=
=

Intengity (cntizec)

4 5pim : Pharma

i~ Shyle

Type 2 C@ * @ Help
Gradation j@ s [ v [ 2 Canicel
Color i ']

Fil [ |

Infengity (cntizec)
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8.10 - 3DAXxes

The 3D Axes Dialog allows you to modify the appearance of the axes for 3D representation of data
objects. You access to this Axes dialog by selecting the Axes item from the window context menu.

> Options
First select the axis you wish to [P &]
customize. ==
- O ptiors -
Ticks .... Check this box to enable the s ¥ Ticks
ing of ticks. ;

drawing of ticks 7 Valiss
Values .. Check this box to enable the r 0

display of the number .

values for ticks. ~ I~ Label
Label..... Check this box to create the e ‘ Eenter] |

axis output label and edit the

label field to customize the | | Stle

axis. Frame — | Values |12 Times -
X<>Y....Click on this button to Ticks m L ahels m

switch between the X and Y

axis. ' _ i '

. . Help J Caricel ‘

Center... Click on this button to re- R i

center the 3D object in the
active window.

> Style

Frame....Click on the control to modify the color and style of axis edge.
Values... Click on thes control to modify the font values

Ticks......Click on the control to modify the color and style of the ticks
Labels....Click on the control to modify the labels font
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9 - Service
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